Techniek: Het samenvoegen van belichtingen

Digitale fotografie blijft verder evolueren en onze camera’s worden steeds beter. Toch blijven
foto’s met hoge contrastverschillen vaak een probleem en slaagt de camera er niet altijd in
om het beeld weer te geven zoals de fotograaf het op dat moment ziet. In dit artikel bekijken
we hoe we ook aan deze situaties een oplossing kunnen bieden. Bart Heirweg -
www.bartheirweg.com

Wie af en toe een landschap fotografeert heeft ongetwijfeld al gemerkt dat een camera
soms problemen heeft om zowel de lucht als de voorgrond goed belicht te krijgen. Het
contrastverschil fussen de felle lucht en de donkere voorgrond is soms te grooft. Dif resulteert
meestal in een te donkere voorgrond of een uitgebrande lucht. Gelukkig bestaan er voor die
gevallen oplossingen. Je kunt gebruik maken van grijsverloopfilters om het contrastverschil te
beperken of je kunt HDR-technieken gebruiken en de belichtingen van twee of meer foto's
achteraf samenvoegen om het contrastbereik uit te breiden. Beide technieken hebben hun
voor- en nadelen en afhankelik van de situatie zal je voor de ene of de andere oplossing
kiezen.

Grijsverloopfilters

Grijsverloopfilters zijn er specifiek om het grote contrastverschil tussen de lucht en de
voorgrond te verminderen, zodat de waarden binnen het dynamische bereik van de
camera vallen. Onder dynamisch bereik verstaan we de verhouding tussen het felste en het
zwakste licht dat door de camera weergegeven kan worden en het wordt uvitgedrukt in
stops. Grijsverloopfilters maken de lucht voor de camera schijnbaar donkerder, zodat de
belichting van de lucht en voorgrond meer in elkaars buurt komen te liggen en de voorgrond
lichter wordt. Op die manier slaagt de camera er wel in om zowel lucht als voorgrond goed
weer te geven en het beeld vast te leggen zoals wij het op dat moment ook fe zien krijgen. Ik
ga niet dieper ingaan op de werking van deze filters, omdat dit ons te wat ver zou leiden,
maar wie zich nog wat meer in deze materie wil verdiepen kan even terugblikken naar het
artikel ‘Filters voor beter landschapsfoto’s’ in Shoot nr. 19.

Wie mijn fotografische activiteiten wat volgt, weet ongetwijfeld dat ik meestal gebruikmaak
van grijsverloopfilters. Ik vind het een uitdaging om in het veld alles in één correct belichte
foto te vatten. Zo zie ik meteen of de foto geslaagd is en heb ik achteraf ook minder werk bij
het nabewerken. Toch zijn er een aantal situaties waar grijsverloopfilters ontoereikend zijn. Het
fotograferen van landschappen met reflecties in het water is zo’'n geval. Een grijsverloopfilter
zorgt ervoor dat de voorgrond wordt oplicht, maar dus ook de reflectie. Het kan dus
gebeuren dat de reflectie lichter wordt dan wat ze reflecteert. Dit oogt erg onnatuurlik en
kan je best vermijden; het verraadt bovendien meteen dat er filters gebruikt zijn. Daarnaast
zijn filters ook minder geschikt bij het fotograferen in fel tegenlicht waarbij de zon deel
vitmaakt van de foto. In die gevallen moet je meestal zoveel filteren dat het resultaat
onnatuurlik oogt en bovendien krijg je ook last van lensflare of ongewenste lichtvlekken in de
foto.

Exposure blending

In die gevallen is het handig dat je ook andere technieken kent om het contrastverschil
onder controle te houden. Eén van die technieken, die ik regelmatig gebruik voor dit soort
situaties, is exposure blending of een manuele samenvoeging van de belichting van
verschillende foto's. Meestal maak je gebruik van slechts twee beelden, waarbij je de eerste
foto goed belicht voor de hooglichten en er dus voor zorgt dat het histogram niet raakt aan
de rechterkant. Vervolgens maak je een tweede foto voor de schaduwen en let je erop dat
het histogram niet raakt aan de linkerkant. Je fotografeert best vanaf een stevig
gepositioneerd statief zodat de foto's identiek zijn, enkel de belichting mag verschillen.
Achteraf kan je deze twee beelden samenvoegen in Photoshop via lagen en maskers. Hoe je



dit precies doet komt straks aan bod. Eigenlik is dit een soort HDR-techniek, waarbij je
manueel de foto samenstelt en dus geen gebruik maakt van HDR-software. Het voordeel is
dat je het eindresultaat veel beter onder confrole hebt en dat je ook die onnatuurlike HDR-
look kunt vermijden. Doordat je slechts gebruik maakt van twee beelden, één voor de
hooglichten en één voor de schaduwen krijg je niet dat overdreven detail in de
middentonen, zoals bij HDR wel vaak het geval is.

Exposure blending is dus een goed alternatief voor situaties die moeiliker op te lossen zijn met
filters. Je gaat twee foto’'s combineren, waarbij je van de ene foto enkel de lucht en van de
andere foto enkel de voorgrond overhoudt. Je kunt op die manier ook lensflare, wat vaak
optreedt wanneer je in tegenlicht fotografeert, proberen te vermijden. Bij het maken van de
foto voor de schaduwen (of dus de voorgrond), kan je de hand voor de zon houden, zodat
de flare verdwijnt. Je zult deze hand in het eindresultaat nooit te zien krijgen, want je laat van
die foto toch enkel de voorgrond zien. Om duidelik te maken wat ik hiermee precies bedoel,
bekiken we een praktikvoorbeeld, waarin ik toon hoe je de twee foto’s samenvoegt in
Photoshop.

Deze foto werd belicht voor de hooglichten.
Het histogram raakt net niet aan de
rechterkant. Door het fotograferen met de zon
in beeld ontstaat flare op de voorgrond.

f/16, 1/13 sec, ISO 100, 29mm op fullframe

De tweede foto werd belicht voor de
schaduwen. Het histogram raakt net niet aan

de linkerkant. Met mijn hand hou ik de flare uit
het beeld.

f/16, 1/4 sec, ISO 100, 29mm op fullframe



e s e s e

Auto-Align Layers
Projection
(o) Auto () Perspective () Collage
= o e Y
F
L 5
() Cylindrical () Spherical () Reposition

Lens Correction
| vignette Removal

|_| Geometric Distortion

Determine the best projection automatically.

Warning: Could not detect camera metadats. Use the “File > Scripts > Load Images into
Stack...” script to preserve metadata for Vignette Removal and/or Geometric Distortion.

Ex

[ cancel |

Stap 1. Werk de beide RAW-beelden af naar
smaak en kies voor ‘Bewerken in > Openen als
lagen in Photoshop'. Je kunt de beelden ook
eerst samenvoegen en daarna verder
afwerken, maar dan werk je niet meer op een
RAW beeld, maar een TIFF of Photoshop PSD
bestand.

Lightroom stuurt de foto’s automatisch naar
Photoshop en maakt voor elk beeld een
laag/layer aan.
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Stap 2. Selecteer de beide lagen en kies voor
‘Edit > Auto-Align Layers’ of ‘Bewerken >
Lagen automatisch uitlijnen’.
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In het pop-up venster kies je voor de opfie
‘Auto’. Je hoeft geen lenscorrectie meer aan
fe vinken, want die is uiteraard reeds gebeurd
in Lightroom.

Photoshop zal vervolgens de lagen correct
uitlijnen zodat ze mooi over elkaar vallen. Dit is
handig wanneer er foch een klein beetje
verschil is fussen de beide foto's.
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Stap 3. Maak nu een masker aan in de
bovenste laag door in het menu te kiezen voor
‘Layer > Layer Mask > Reveal All' of onderaan
het ‘layers paneel’ te kiezen voor ‘Add layer
mask’

Naast de foto verschijnt nu een wit vierkant. Dit
is het masker voor deze laag. Alles wat wit is in
dit masker wordt in de foto getoond, wat zwart
is wordt niet getoond.

Screenshot_7.jpeg



Stap 4. Selecteer het masker dat je net
aanmaakte, kies voor de ‘Gradient tool’ in het
‘Tools ' palet en sleep over de foto tot je het
gewenste effect bekomt.

In het masker wordt nu een gradiént
aangemaakt die langzaam overgaat van wit
naar zwart. M.a.w. krijg je bepaalde delen van
de bovenste laag (of foto) te zien en andere
delen niet. Hoe hard of zacht deze overloop
moet zijn, kan je bepalen door je gradiént
dieper of minder diep te trekken.

Is de overgang nog niet helemaal perfect dan
kan je met de ‘brush’ of het ‘penseel’ nog
bijsturen door met een zeer lichte dekking met
wit of zwart te verven, zodat er van de
bovenste foto meer of minder getoond wordt.
Je bent als het ware ‘dodge en burn’
fechnieken aan het toepassen om bepaalde
delen lichter of donkerder te maken.
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Stap é. Je hoeft nu enkel nog de lagen samen
te voegen en eventueel de foto wat bij te

snijden indien tijdens het aligneren wat lege
pixels zijn ontstaan aan de randen.

_DSC2544_final.jpeg

Luminosity masks

Er bestaan uiteraard nog meer manieren om de belichfing van verschillende foto’s samen te
voegen. In bovenstaand voorbeeld heb ik een vrij duidelike overgang tussen de lucht en de
voorgrond, maar dat is niet altijd zo. Soms steken er bomen of gebouwen boven de horizon
uit en dan wordt het al wat moeilijker om gebruik te maken van een gradiént gebaseerd
masker. In die gevallen kan je beroep doen op ‘luminosity masks' of maskers gebaseerd op
de helderheid van bepaalde tonen in een foto. Het voordeel van dergeliike maskers is dat ze
automatisch over een ‘doezelwaarde’ of ‘self-feathering’ beschikken zodat de overgang
tussen de verschillende lagen vloeiend overkomt. Vooraleer we luminosity masks in werking
zien, geef ik nog even mee dat dit een sterk vereenvoudigde tutorial is en dat je met
luminosity masks nog veel verder kunt gaan dan wat ik nu laat zien. Om het geheel
overzichtelik te houden heb ik me echter beperkt tot de essentie.

Luminosity masks vind je in het ‘Channels’ palet in Photoshop. Je kunt zelf maskers
aanmaken, maar online vind je ook een heleboel gratis acties die dit werkje een stuk
eenvoudiger maken. Ik raad de ‘JM Luminance masks’ van Jimmy Mclntyre aan. Als je deze
Photoshop actie laat lopen, zal je zien dat er in het Channels palet, onder de RGB kanalen



een heleboel extra kanalen zijn verschenen. Op basis van één van deze kanalen zullen we
een masker aanmaken om twee beelden samen te voegen.

Stap 1. We starten opnieuw met beide foto's
en maken hiervoor een laag aanin
Photoshop. Zorg ervoor dat ze mooi
gealigneerd zijn (zie hoger) en zet de
donkerste laag bovenaan.
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Stap 2. Ga naar het ‘channels’ paneel en
selecteer het kanaal waarbij je het meest
contrast ziet tfussen de hooglichten (lucht) en
de schaduwen (voorgrond). In ons geval is
dat ‘Brights 1.

Sleep vervolgens dat kanaal naar ‘load
channel as selection’ in de linkeronderhoek
van dit paneel om op basis daarvan een
selectie te maken.

Photoshop selecteert nu de tonen die
minimum 50% grijs of lichter zijn. Op die
manier worden dus vooral de lichte delen in
de foto geselecteerd.
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Stap 3. Behoud de selectie en selecteer
opnieuw het RGB-kanaal. Ga daarna terug
naar het ‘Layers’ paneel.

Met de bovenste laag geselecteerd kies je
onderaan voor ‘add layer mask'.

Op basis van de selectie wordt nu een
masker aangemaakt die van de bovenste
laag vooral de hooglichten laat zien.

Het resultaat oogt meestal vrij viak en
wellicht moet je nog een ‘curves
aanpassingslaag’ gebruiken om het contrast
in de foto te optfimaliseren.
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HDR-functie

Een laatste manier om foto’'s samen te voegen die ik tegenwoordig af en toe gebruik is de
nieuwe HDR-functie in Lightroom 6. Die kan je activeren door de beelden te selecteren die je
wilt samenvoegen en door daarna in het menu te kiezen voor ‘Foto > Foto Samenvoegen >



HDR'. Er opent vervolgens een pop-up venster waarin je een aantal zaken kunt instellen die
de look van het HDR-beeld beinvioeden.

HDR-functie in Lightroom.
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Deze manier van werken heeft enkele grote voordelen. Het is een vrij eenvoudige werkwijze,
want het meeste werk wordt voor jou gedaan. Je blijft in Lightroom en hoeft geen ander
programma te installeren of te openen. Het resultaat is vrij neutraal en oogt vrij realistisch in
tegenstelling tot bij sommige andere HDR-software. Het samengestelde beeld is fevens een
DNG-bestand. Je behoudt met andere worden de flexibiliteit en de kwaliteit van een RAW-
foto.

Je hebft niet zoveel mogelikheden om het resultaat bij te sturen, maar als het snel moet gaan
en voor minder complexe beelden is dit een prima oplossing. Nadat het HDR-beeld werd
aangemaakt kan je het nog verder optimaliseren. Je zult onder andere de toning en de
contrasten nog moeten aanpassen, want het beeld zal vrij viak ogen. Uiteraard is de HDR-
functie in Lightroom niet geschikt voor opnames waarbij je de hand hebt gebruikt om flare uit
het beeld te houden. Bovendien is het samenvoegen van belichtingen dan weer minder
interessant als je te maken hebt met situaties waarbij veel beweging aanwezig is in het
landschap. Als in de ene foto een boom naar links is gewaaid en in de andere foto naar
rechts, dan zullen deze beelden moeilijk samen te voegen zijn. In die gevallen zijn filters dan
weer een betere keuze.

Besluit

Zodals je ziet bestaan er verschillende manieren om een oplossing te bieden aan het enorme
contrastbereik waarmee je bij landschapsfotografie vaak te maken krijgt. [k maak bij
voorkeur gebruik van filters, maar in sommige situaties zijn ze ontoereikend. In die gevallen is
het handig daft je andere technieken kent en dat je gebruik kunt maken van exposure
blending om de belichting van verschillende foto's samen te voegen. Het is belangriik om
hierbij niet uit het oog te verliezen dat het om natuurfotografie gaat en dat resultaat steeds
natuurlik moet blijiven. Vermijdt dus die echte HDR-look en laat het landschap zien zoals je
het tijidens de opname beleefd hebf.



